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#ÈÁÐÔÅÒ /ÎÅȡ )ÎÉÔÉÁÌ 3ÅÔÕÐ 
              

 

Understanding the "Big Picture"  
 

As you prepare to implement Prevail  in your  practice, it  is critical to remember several key 

points. 

 

Å Proper imp lementation  of Prevail  requires planning. It's extremely import ant to chart 

your course before you set sail using Prevail.  Your Prevail  trainer can provide  helpful  

guidance on things that you'll  need to determine from  the get-go, such as the naming 

convention you'll  use for  your  merge document templates and how to map out your  

work  flow using the Process Builder,  among many others. 

Å Tryi ng to fit  Prevail  into your  old  way of thinking is doing yourself  a disservice! 

Å You need a staff  member who will  "drive  the ship".  The implementation  and ongoing use of 

Prevail  is a group effort  that requir es your  whole staff  to be on board. 

Å Prevail  is based on the centrali zation  of data and complete accountabili ty  for  everyone and 

everything. It  is designed so that, when used properly,  nothing will  fall  through  the cracks. 

Å All  staff  members must use Prevail  in a consistent manner. Accurate reports 

generated through  Prevail  rely  on this consistency. 

 

Basic Terminology  
 

Below are definitio ns of several terms used throughout Prevail  and in this manual. 

 

Term Definition 

Matter A matter in Prevail  is a case. Just like  a hard  copy or electronic file  on your 

computer, you'll  enter all of your  notes, appoi ntments, tasks, documentation, 

etc., in your  client's matter. 
 

 

If  it's an active case that you've already signed up, it's considered an open 

matter. If  it's a case you've already handled and completed, it's a closed matter. 

In Prevail,  we clearly  identify  the closed matters so that you don't confuse 

them with  open matters. 

Prospect A prospect is a matter, but refers specifically  to a potential client that you are 

not offici ally  representing. Like matters, prospects can be open or closed (i.e., 

active or inactive), and you can easily  convert  them to matters in Prevail  when 

the potential client signs up for  your  services. 
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Basic Terminology (continued)  
 

Term Definition 

Contact You enter your  clients and all  related parties (e.g., medical providers, opposing 

parties, judges) in Prevail  as contacts. Your Contacts in Prevail  is a central 

repository  for all  persons, companies, and entit ies involved  with  your  cases. 

User A user in Prevail  is an employee of your  firm. Each user has a unique login so 

that Prevail  can track their activity  in the progr am. Warnings, reminders, 

system messages, appoi ntments, etc., are all  directed to specific users, so it's 

import ant that each user log in to Prevail  using his or her own  unique user 

name. Prevail  is licensed by concurrent user. Therefore, you may create as 

many users in Prevail  as you wish. The number of licenses you own determi nes 

how many of those users can be logged in at the same tim e. 

Task Tasks are "to do" items. You use them in Prevail  to assign actions or duties to 

users. Tasks are usually  associated with  a matter, but you may also have tasks 

that aren't associated with  a specific case. After  the user has completed the "to 

do" item, he or she can mark  the task as complete in Prevail.  

Appoi ntment An  appoi ntment in Prevail  is exactly what the name implies;  it  is an event 

where a user (or users) is supposed to be at a particul ar place at a particu lar 

time for  a particul ar duration  of time. Hearings, depositions, and meetings are 

all  examples of appoi ntments. The differe nce between a task and an 

appoi ntment is that a task has a due date, but no particular start  or end time. 

Tabs When you are worki ng in a specific matter in Prevail,  you' l l notice a row  of 

tabs at the bottom of your  screen. These tabs correspond with  specific aspects 

of the matter, as described below. 

Tab Description  

Ledger You will record all time, cost, and fee entries on the 

Ledger tab. 

Trust Ledger You will track deposits into, and payments from, 

your trust account(s) on the Trust Ledger tab. 

Damages You will record medical expenses, property 

damage, lost wages, and other damages incurred by 

your client on the Damages tab. 
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Basic Terminology (continued)  
  

Term Definition 

Tabs When you are worki ng in a specific matter in Prevail,  you' l l notice a row of 

tabs at the bottom of your  screen. These tabs correspond with  specific aspects 

of the matter, as described below. 

Tab Description  

Photo All photos related to the matter (e.g., photos of 

injuries or property damage) display on the Photo 

tab. Any photo attached to the History tab will also 

automatically display on the Photo tab.  

Medical  You will track all details ÈÚÚÖÊÐÈÛÌËɯÞÐÛÏɯÈɯÊÓÐÌÕÛɀÚɯ

Medical Treatment including provider name, 

treatment dates, as well as dates of records 

requested and received. 

Evidence Similar to the Medical tab, the Evidence tab 

displ ays a list of other types of records (e.g., police, 

military, school) that you have requested and 

received regardi ng a matter. 

Employment  Track the details of your  client's employment 

history on the Employment tab. 

Disabilities  Record the severity, treatment, dur ation, and other 

details of your  client's ailments on the Disabiliti es 

tab. 

Strategy The Strategy tab is a simple area to record notes 

regardi ng your  overall  theory of a case and your  

general "pl an of attack". 

Negotiations  Record liens, demands made, and offers received on 

the Negotiations tab. 

Process/Claims You wi ll use your  fir m-defined workflows  and 

checklists on the Process/Claims tab. 

Events The Events tab lists all appointments (past, future, 

cancelled, and rescheduled) associated with the 

matter, as well as all pending (i.e., not completed) 

tasks associated with the matter. 
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Basic Terminology (continued)  
  

Term Definition 

Tabs  

Tab Description  

Portal The Portal tab lists messages and files exchanged 

between your firm and the client via the Prevail 

Client Portal.  
 

 

Adding Your Firm to Contacts   
 

Contacts in Prevail  are the backbone of the Prevail  system. Plainti ffs, claimants, 

defendants, medical providers, insurance companies, government agencies, opposing counsel, 

referral sources, and any other parties you can think of all  reside in your  Prevail  Contacts. Each 

unique party has only  one entry  in your Contacts. Then, you can attach each of these parties to 

as many matters as you like, in whatever role the situation  requires. 

 

In later chapters, àÖÜɀÓÓ learn how to add parties to Contacts and attach them to the matters, but 

your  first task is setting up your own  ÍÐÙÔɀÚ Contacts entry.  

 

The very fi rst ÌÕÛÙàɯàÖÜɀÓÓɯÕÌÌËɯÛÖɯÈËËɯÛÖɯàÖÜÙɯ"ÖÕÛÈÊÛÚɯÐÚɯàÖÜÙɯÖÞÕɯÍÐÙÔ. Prevail  pulls  the 

inform ation  for  your  merge documents from  your  fiÙÔɀÚ Contacts entry.  

 

*Note: If  your  firm  has more than one office, repeat the followi ng steps for  each office. Follow  

these steps to add your  off ice to your  Contacts. 

 

Step Task 

1 Click  into the Search Bar at the top left-hand corner of the Prevail toolbar. 

2 Type the word sample and press Enter on your keyboard. 

3 Double-click on the sample Branch Office contact to open that entry.  

4 Enter the name of your  firm  in the Office/Comp any/Firm  field.   
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Adding Your Firm to Contacts  (continued)  
 

Step Task 

5 Enter your  firm's  maili ng address in the Maili ng Address section. Note that entering 

your  zip  code will  automatically  popul ate the city  and state fields. 

If  your  firm 's maili ng and physical addresses are the same, then check the "Physical 

Same as Maili ng" box. Otherwise, uncheck that box, and enter your  firm's physical 

address in the Physical Address fields. 

6 In the Communications section on the right side  of the wind ow, click 'Add'  to add your 

fir m's phone number, fax number, web address, etc. For each of these types of phone 

numbers/addresses, select the appr opri ate type from  the Type drop-down  list, and enter 

the phone number, email address, or web address. Check the "Primary"  box for  your 

pri mary  telephone number and email  address. After  making  each entry, click 'Save'. 

7 Click ȿ2ÈÝÌɀȭ 

 

Adding  Other  Branch Locations of Your  Firm to Contacts  
 

Alt hough your firm (li ke any other party)  should  only  have one entry  in your  Contacts, you will 

need to set up an indiv idual entry  for  each branch office (physical location) of your  firm.  
 

 

If  your  firm  has only  one location, you may skip this procedure! 

 
Follow  these steps to set up individu al Contacts entries for  each of your  ÍÐÙÔɀÚ branch offices. 

 

Step Task 

1 Enter your  firm's  name in the search field  in the upper -left  corner of Prevail,  and press 

Enter (or click the binoculars button  to the right of the search field).  

2 If  you are not already on it,  go to the Contact Search tab at the bottom of the next 

wi ndow.  

3 Double-click on your  existing Branch Office entry  to open it.  

4 Click  the 'Clone' button  at the top of the wi ndow. 

5 Delete the word ɁȻ"+.-$#ȼɂ from  the firm  name in the Off ice/Company/Firm  field, 

and give this branch office a unique name (differe nt from  the name you gave your 

other branch office). For example, you might designate this office as ɁDowntown 

Officeɂ. 
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Adding  Other  Branch Locations of Your  Firm to Contacts 
(continued)  
 

Step Task 

6 Repeat steps 5-7 from  the Adding Your Firm to Contacts procedure on page 3 to 

finish setting up the Contacts entry  for  this branch office. 

 

Secur ity/Group  Setup  
 

Security  Groups are what Prevail  uses to determine who wit hin your  firm has access to which 

matters. Each matter must have a security  group assigned to it.  Each user may have a different 

role and level of access wit hin each security group. Furthermore, you can allow  for  exceptions 

to the security  group  for  a particul ar matter. 

 

If  àÖÜɀÙÌ at a small  firm  where everybody  works  on every case and nobody needs to be kept 

from  viewi ng any matters, then youɀll  only  have one security group  (the Default  Group, which 

already exists in the system) and every  user will  belong to that group.  Each user will  belong to 

that group  in some capacity  (e.g. employee type: attor ney, secretary, paralegal, etc.). If  thaÛɀÚɯÛhe 

case, you can simply  add every employee to the default  security  group and àÖÜɀÙÌ done.  

 

+ÌÛɀÚ assume, however, that your  practice is a little  bigger and you have differe nt teams wit hin 

the firm,  and those teams work  on differe nt cases. You may or may not want all  (or any) 

members of one team to be able to access another teaÔɀÚ cases. You may have some members of 

your  staff  (like  the administrator or bookkeeper) who might work  on MULTI PLE teams and 

need access to those cases. Prevail  accommodates this by allowi ng you to have multiple  groups, 

and allowi ng indivi dual users to belong to more than one group. Furthermore, each user can 

have differe nt security settings wit hin each group.  
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Secur ity/Group  Setup (continued)  
 

Follow  these steps to create a Security  Group.  

 

Step Task 

1 In Prevail,  click Admi nistration  > Security/Group Setup. A window  simil ar to this one 

will  displ ay: 

 

2 Click  the 'Add'  button  on the left  to create a new group . Give the group and  

È××ÙÖ×ÙÐÈÛÌɯÕÈÔÌȮɯÚÜÊÏɯÈÚɯɁ22#ɯ&ÙÖÜ×ɂɯÖÙɯɁ/ÌÙÚÖÕÈÓɯ(ÕÑÜÙàɯ&ÙÖÜ×ɂȭ 

3 To attach a user to that group,  click  the 'Att ach To Group' button. This wi ndow  will 

displ ay: 

 

4 Select the user you want to add using the User drop-down  menu, and then choose the 

role that user will  play in this group  under the Action  drop-down  menu. Then, click 

'Save'. 

*Note: If  there aren't any users to select, remember that you have to set up the user, 

under Adm inistration  > Employee Setup, before his or her name will  appear in the 

drop -down  list. 

 

At  the bottom left hand corner of the Security/G roup Setup wi ndow,  there is also a  Security  tab. 

On this tab, you can add, edit, or delete employee types. For each employee type listed on the 

left  side of the window,  select the desired security settings on the right side of the wi ndow. 

These settings control  access to certain tabs and functions wit hin Prevail.  
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Security/Group Setup (continued)  
 

Also notice that each employee type can be configured  to appear in the matter screen drop- 

down  lists for Lead Attor ney and Hearing Attor ney by checking the Attor ney box. Similarly, 

checking the Case Manager box will  cause employees of this type to appear in the matter screen 

drop -down  list  for  Case Manager. Check the Statute Warning box for  any employee types that 

you want to receive Statute Warning notific ations. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

  *NOTE: Anyone designated as any type where the Statute Warning box is checked, in 

any group,  wi ll automatically  get popup  reminders and statute warnings. Also, each user who 

is allowed  to receive statute warnings may change their settings on the Home screen. 

 

For exampl e, let's say you have an employee type for  "Network  Admi nistrator," and check the 

Statute Warning box for  that type in the Security setup. Then, you attach user MARY in the role 

of Network  Admi nistrator to the Default  group.  Thereafter, for  any matters that are assigned to 

the Default  Group, MA RY wi ll receive statute warnings via pop-ups and/or  the Statute Warning 

List  on the Home tab, even though she may not be responsible for  meeting those deadli nes 

(since, more than likely,  it  would  be the attorney or case manager, not the network  

admi nistrator, who is the responsible party).  However, MA RY can click the Optio ns button 

above the Statute Warning List, and select which users' statute warnings she wants to see in the 

list. 

 

Under the Prevail Security Information section, you can select the access level for each employee 

type for the Medical, Claims/Process, Ledger, and Trust Ledger tabs, and the document merge 

function. The choices include: 

¶ No Access ɬ the tab or function would not display at all for the employee type  

¶ View Only ɬ the tab would display for the employee type, but the user would not be 

able to add, delete, or modify the data on that tab in any way  

¶ Add, Edit, Delete, and View ɬ the employee type would have full access to the tab or 

function  
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Setting  Up User Accounts  
 

*Note: Only  users with  "Add,  Delete, Edit  and View"  access to the Employee Security section of 

Prevail  may set up new user accounts. 

 

 

 

Follow  these steps to set up a Prevail  user account. 

 

Step  Task 

1 Click  Ad ministration  > Employee Setup.  

2 Click  'Add'  on the left  side of the window.  

3 Enter a login name for  the employee, which will  appear in all  caps. 
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Setting  Up User Accounts (continued)  
 

Step  Task 

4 Complete the followi ng fields: 

Å Date Hired  

Å Salut ation  

Å First name 

Å Middle  name 

Å Last name 

Å Suffix 

Å Initi als 

Å Branch Offi ce 

Å Professional Title, Bar Number,  and Rate (if  applic able) 

Å Maili ng Address ȹÌÔ×ÓÖàÌÌɀÚɯ×ÌÙÚÖÕÈÓɯÔÈÐÓÐÕÎɯÈËËÙÌÚÚȮɯÕÖÛɯÛÏÌɯÖÍÍÐÊÌɯÈËËÙÌÚÚȺ 

*Note: By default,  the "Physical Same as Maili ng" box is checked. If  the employee's 

maili ng address differs  from  his or her physical address, uncheck this box, and 

enter the maili ng address in the fields that will  displ ay. 

Å Phone Number(s)  and Email  Addre ss(es). Under the Communications section  in 

the lower  right, click the + button, and choose the type of phone number, email 

address, or website to enter. Then, enter the information, and check the 

"International" and "Prim ary"  (if  it  is the prim ary  phone number, email  address, or 

website for  the employee) boxes as necessary. 

*Note: You may choose to complete the remaining fields in this w indow  (e.g., 

Nick name, Social Security  Number,  Date of Birth), but many of our clients choose not 

to include this personal inform ation. 
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Setting  Up User Accounts (continued)  
 

Step Task 

5 Click  on the Security  tab at the bottom of the window.  On this tab, you will  choose 

what type of access, if  any, the employee has to these specific areas of Prevail:  

Å   Control  Panel Security  

Å   Databank Security  

Å   Document Setup Securi ty 

Å   Employee Security  

Å   Firm Log Security  

Å   Process Builder Security  

Å   Query Manager Setup 

Å   Questionnaire Security  

Å   Questionnaire Setup Security  

Å   Report Security  

Å   Report Designer Setup 

Å   Contact Setup Security  

Å   Trust Account Security 

Å   Contact Consolidate Security 

Å   Dashboard  Security  

*Note: When you set up your  securi ty groups, under Admi nistration  > Security/G roup 

Setup, you will  select the access setti ngs for  several other areas of Prevail.  In that area, 

instead of selecting access by indivi dual employee, you will  select access by employee 

type (e.g., Attor ney, Paralegal, Receptionist). 

6 Also on the Security  tab, you will  need to attach the employee to the appropri ate 

group(s), and choose their  level of access in that group.  (For more inform ation  about 

security groups, see Security /Group Setup on page 5.) In Prevail,  when you create a new 

matter or prospect, it  is automatically  assigned to the "Default"  security group  if you 

do not set up any other groups. However, if  you have multiple groups, you will need 

to select the desired group. This group  security  controls which employees can access 

the file, and what level of access (i.e., what information  in that matter) they will have. 
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 Setting  Up User Accounts (continued)  
 

Step Task 

7 *Note: If  you use an Exchange server, you will  set up the sync on the Sync tab. If  you 

do not use an Exchange server, your  users can still  use the Outlook  Sync, but wi ll 

configure  it under the File > User Settings menu. For more inform ation, see User 

Settings on page 15. 

Click  on the Sync tab at the bottom of the wi ndow. Prevail's Outlook  Sync allows 

users to synchronize appoi ntments between their Prevail  and Outlook calendars. This 

is a live, two -way sync. Therefore, upd ates to either calendar are synced to the other. 

If  you are not absolutely  certain of the exact Exchange profile  name for  each user, do 

not guess! Consult your  network  administrator or IT professional. 

8 Click  on the Notes tab at the bottom of the wi ndow. If  desired, enter any 

miscellaneous inform ation  about the employee. 

9 Click  'Save'. 
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Deleting  User Accounts 
 

Follow  these steps to delete a user account. 

 

Step  Task 

1 Click  on Administration  > Employee Setup. 

2 Click  on the employee's name in the list  on the left  side of the User Preferences 

wi ndow.  

3 Click  on the 'Delete' button  on the left  side of the User Preferences wi ndow. 

4 Click  'Delete' to confirm  that you want to delete the employee. 

5 Select a Lead Attor ney, Hearing Attor ney, Case Manager to whom you want to assign 

the former  employee's assigned matters; select a user to whom you want to assign the 

former  employee's pending appoi ntments and pending tasks. 

*Note: Even if the former employee was not assigned as the Lead Attorney, Hearing 

Attorney, or Case Manager in any matters, you will still need to select another user to 

whom his or her matters should be assigned. 

 

 

6 Click  'Finish'.  
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#ÈÁÐÔÅÒ 4×Ïȡ 5ÓÅÒ 3ÅÔÔÉÎÇÓ 
              

 

Each Prevail  user has access to a number of indivi dual user settings which allow  them to 

custom tailor  certain parts of Prevail  to suit their preference. To access your  user settings, go to 

File > User Settings. You'll  see a screen like  the one below. 

 

 

 

User Settings  
 

This table explains the tabs at the bottom of the User Settings wi ndow.  

 

Tab Details 

Contact Much  of the inform ation  on the Contact tab may have already been entered by 

your  Prevail admi nistrator. 
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User Settings (continued)  
 

Tab Details 

Settings 

(Calendar 

Information)  

Startup  Calendar ɬ allows  you to pick  your  preferred calendar view  and have 

it  launch automatically,  with  your  default  calendar setting, when you log in to 

Prevail.  If  much of your  responsibility  revolves around setting and confirmi ng 

appoi ntments for  other users, this option  will  probably  be helpful si nce the 

Home tab only  shows your  own  upcoming appoi ntments over the next 14 

days. 

 
Default  Calendar ɬ allows  you to select one or more ÜÚÌÙɀÚ calendars as your 

default  view. Whenever you open the calendar, àÖÜɀÓÓ see the selected usÌÙÚɀɯ

calendars, side by side, in your  preferred view.  If you  selected an option  in 

Startup  Calendar, your  Default  Calendars will  launch automatically  when 

you login. 

 
Start  of Day; End of Day; and Time Blocks ɬ these settings affect how your 

calendar Day View  will  look, as well  as the default  dur ation  for  a new 

appoi ntment. Also, if  you schedule an appoi ntment and check the All  Day 

box the start  & end tim es will  match your  Start  of Day and End of Day 

settings. 

 
New Appt  Warning  Days ɬ this setting allows  you to receive new 

appoi ntment warning notices more than one day in advance of the 

appro aching appoi ntment if  you wish. 

 
New Task Warning  Days ɬ this setting allows  you to receive new task 

warning notices more than one day in advance of the appro aching task if 

you wish. 

 
Appoint ment  Reminder ɬ allows  you to select how far in advance of an 

upcomi ng appoi ntment (from  zero minutes to eight hours) you want to 

receive a reminder. 
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User Settings (continued)  
 

Tab Details 

Settings 

(Calendar 

Information) 

(continued)  

2nd Appointment  Reminder ɬ allows  you to select how far in advance of an 

upcomi ng appoi ntment (from  zero minutes to eight hours) you want to 

receive a second reminder. The 2nd Appoi ntment Reminder should  alw ays 

be a smaller  value than the Appoi ntment Reminder (e.g., Appoi ntment 

Reminder = 1 hour; 2nd Appoi ntment Reminder = 15 minutes). 

 

Time Zone ɬ ÚÌÓÌÊÛɯÛÏÌɯÛÐÔÌɯáÖÕÌɯÛÏÈÛɯÛÏÌɯÜÚÌÙɀÚɯÈ××ÖÐÕÛÔÌÕÛÚɯÚÏÖÜÓËɯ

display in.  

 

Use Daylight Savings Time  ɬ ÊÏÌÊÒɯÛÏÐÚɯÉÖßɯÐÍɯÛÏÌɯÜÚÌÙɀÚɯÈ××ÖÐÕÛÔÌÕÛÚɯ

should adjust for Daylight Savings Time  

 

Word Processor ɬ this setting is selected duri ng the install ation  process. 

 
Popup Windo ws Stay On Top ɬ checking this box will  cause any popup 

wi ndows, message wi ndows (e.g., task or appoi ntment reminders), task 

completed messages, etc., to remain open and on top of your  main Prevail 

wi ndow  till  you close them. This sett ing is most often used by people who 

are frequently  called  away from  their desk. That way they wonɀÛ miss any 

messages that appeared while they were away. 

 

Button Tips ɬ When this setting is checked and you hover your mouse 

over a button, a description of that button will appear.  

 
Prompt  for  confirm ati on on exit ɬ with  this box checked, when you 

attempt  to exit Prevail,  the system will  prompt  you with  a confirm ation  

message where you must  click one of the followi ng: Exit Prevail,  or Cancel. 

 

Receive Appoint ment  Messages ɬ if  this box is not checked, you will  not 

receive messages advising you when other users schedule appoi ntments 

for  you. 

 

Receive Task Messages ɬ if  this box is not checked, you will  not receive task 

messages advisi ng you when other users schedule tasks for you, or 

complete tasks àÖÜɀÝÌ assigned to them. 
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User Settings (continued)  
 

Tab Details 

Settings 

(Miscellaneous 

Information)  

Alert Dock Side  ɬ allows you to dock your messages and reminders in your 

preferred location.  

 
Alert  Durat ion ɬ allows  you to set how long your  alerts will  remain on the 

screen at your  selected dock location. 

 

Grid Name Display  ɬ ÈÓÓÖÞÚɯàÖÜɯÛÖɯÚÌÓÌÊÛɯÏÖÞɯàÖÜɯÞÈÕÛɯÜÚÌÙÚɀɯÕÈÔÌÚɯÛÖɯ

ËÐÚ×ÓÈàɯÐÕɯÎÙÐËÚɯȹÌȭÎȭȮɯÏÖÞɯÛÏÌɯɁ ÜÛÏÖÙɂɯÊÖÓÜÔÕɯËÐÚ×ÓÈàÚɯÛÏÌɯÜÚÌÙɀÚɯÕÈÔÌɯ

in History). Your choices are Login (ex: MSMITH), First Last (ex: Mary 

Smith), or Short (ÛÏÌɯÌÔ×ÓÖàÌÌɀÚɯÕÐÊÒÕÈÔÌɯÈÚɯÌÕÛÌÙÌËɯÐÕɯÌÔ×loyee setup). 

 

Employee Search Window ɬ this setting applies to messages, and the 

calendar, tasks and appointments, as well as drop-down lists of user names 

(e.g., Case Manager, Hearing Attorney, and Lead Attorney drop -down fields 

on the Matter tab). It toggles between a dropdown checklist of employees, or 

a separate employee listing window.  

 

The display options are shown and explained below.  
 

 

 

 
The optio n on the left  above is fair ly self-explanatory,  as it  is uses 

standard checkboxes that you select or deselect for  the users to include 

in the appoi ntment. 
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User Settings (continued)  

 

Tab Details 

Settings 

(Miscellaneous 

Information)  

(continued) 

For the option  on the right on the previous page, on the left  side of the 

wi ndow,  you will  see all employees (Prevail  users) who have not been 

selected for  this appoi ntment. On the right you will  see all  employees 

who HAVE  been selected for this appoi ntment. Double-clicking on any 

name in either column w ill  cause it  to move to the other column. You 

can also choose (using the buttons to the right of the 'Save' button), 

either ALL  users or NO users. Regardless of which mechanism you 

use to get there, once the column  on the right reflects the user or users 

on whose Calendar you want this appoi ntment to appear, click the 

'Save' button. That dialog box will  close, and you can save the 

appoi ntment by clicki ng on the 'Save' button  at the top of the 

appoi ntment wi ndow.  

 

Spell Checker ɬ toggles the spell checker on and off. 

 

Capitalize First Letter After Period ɬ When this box is checked, Prevail will 

automatically capitalize the first letter of each sentence in note fields. 

 

Startup Dashboard  ɬ When this box is checked, the dashboard tab launches 

upon startup of Prevail.  

 

Private Appointments  ɬ When this box is checked, any unattached 

appointments (i.e., appointments not attached to any contact, matter, or               

prospect) will be marked as private by default.  

 

Color Categories ɬ When this box is checked, History entries will display 

the color assigned to them in the Databank. 
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User Settings (continued)  

 

Tab Details 

Sync If  you're using Microsoft's Exchange Server for  your Outlook  email,  and it 

has already been set up in Prevail,  your  Sync Type will  already be set to 

Exchange, and you will  not be able to change the settings on this tab. If  you 

are not running Exchange, this tab is where you configure  your  local Out look 

sync to sync your  Prevail and Outlook  calendars. If  you're not sure if  you're 

running Exchange or not, DO NOT GUESS! When you see the screen below, 

please contact your  network  admi nistrator before saving these setti ngs. 

(ÍɯàÖÜɯÈÙÌɯÜÚÐÕÎɯÛÏÌɯÓÖÊÈÓɯÚàÕÊȮɯÈÍÛÌÙɯàÖÜɯÚÌÓÌÊÛɯɁ+ÖÊÈÓɂɯÍÙÖÔɯÛÏÌɯ2àÕÊɯ3à×Ìɯ

drop -down menu, the computer name and user name will auto -populate.  

"ÏÌÊÒɯÛÏÌɯÉÖßɯÛÖɯɁ+ÈÜÕÊÏɯ.ÜÛÓÖÖÒɯ2àÕÊɯÈÕËɯ ÜÛÖÔÈÛÐÊÈÓÓàɯ+ÈÜÕÊÏɯÈÛɯ

6ÐÕËÖÞÚɯ2ÛÈÙÛÜ×ȭɂ 
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User Settings (continued)  

 

Tab
b 

Details 

Appearance The Appearance tab allows  you to personali ze your view of Prevail.  
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 

 
Toolbar  Style - 

Consolidated: 

 
Standard: 

 
 
 

Highli ght  Color  - This is the highli ght color for  "required"  fields, and past due 

tasks/statute warnings. 

 
Font Name and Size- These settings apply  to the text and field names in 

Prevail.  It's import ant to note that they are somewhat affected by your  screen 

size and resolution  settings. 

 
Skins &  But tons - Pick the ones you like  to customize the appearance of 

Prevail.  If  more than one Skins and/or Button style is selected, a random 

selection will  be used each time you open Prevail.  
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User Settings (continued)  
 

Tab Details 

Shortcuts You can create a keyboard  shortcut  for just about every action you can take 

in Prevail.  

 
 
Click  the 'Add'  button, and you see this screen. 

 
 
 
  
 
 
 
 
 
Select the Shortcut  key or key combination, and the Action  you want it  to 

trigger,  and click 'Save'. Once you save a shortcut,  its related key and action 

will  be removed from  their respective lists (so that you won't accidentally 

create two  shortcuts for  the same action, or have the same shortcut  for  two 

differe nt actions). 
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#ÈÁÐÔÅÒ 4ÈÒÅÅȡ  !ÄÍÉÎÉÓÔÒÁÔÉÏÎ -ÅÎÕ 
              

 

Designated Prevail  users with  the approp riate security  settings will  use the Admi nistration  

menu to accomplish a variety  of tasks wit hin Prevail,  such as creating/modifyi ng merge 

document templates, creating/modi fying Contact types, and modifyi ng user-definable lists. 

 

Law Type/Case Type/ Contact  Type Setup  
 

Law Types 
 

In Prevail,  "law types" refer to the areas of practice in which a firm  speciali zes, such as Social 

Security,  personal injury, workers'  compensation, bankruptcy,  etc. A matter's law type 

determines the fields that will  displ ay on the Matter tab for  that particu lar case. 
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Law Types (continued) 
 

Follow  these steps to modify  the settings for  a law type. 

 

Step Task 

1 Click  on Administration  > Law Type/Case Type/Contact Type Setup, and click on the 

Law Types tab at the bottom. 

2 By default  Ü×ÖÕɯÐÕÚÛÈÓÓÈÛÐÖÕȮɯÛÏÌɯȿ ÊÛÐÝÌɀɯÉÖßɯÞÐÓÓɯÉÌɯÊÏÌÊÒÌËɯÍÖÙɯÈÓÓɯÓÈÞɯÛà×ÌÚȭɯ(ÍɯàÖÜɯ

firm does not practice a particular law type, you may uncheck the box.   

3 If  you wou ld like  for  your  client's contact inform ation  to display on the lower-right 

side of the Matter tab, check the "Display Client" checkbox. Otherwise, leave this box 

unchecked. 

*Note: When you choose to displ ay the contact inform ation, it  will  require more 

scrolling when reviewi ng inform ation  on the Matter tab. 

4 Check the "Current Process Steps" box if you would like a list of the  current step for  

all  processes added to the matter (on the Claims/Process tab) to display  on the right 

side of the Matter tab. Note that, as with  step #3 with  the "Disp lay Client" 

inform ation, if  you choose to have current process steps listed on the Matter tab, it  

will r equire more scrolli ng when reviewi ng inform ation  on the Matter tab.  
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Law Types (continued) 
 

Step  Task 

5 In the Incident Date/Onset Date drop -down  list, you may choose one of the followi ng 

combinations of fields to displ ay on the Matter tab for  this law type: 

Å Incident Date/Statute Date ɬ Use this setting for  a law type in which you want 

Prevail  to autom atically  calculate the Statute Date based on the case type and 

number of statute years selected in Case Type Setup. Users will  not be able to 

manually  override the Statute Date. You would  also use this setting for  law types 

in which there is an incident date, but no statute date. 

Å Incident Date/Statute Date/Statute Override ɬ This setting works the same way the 

Incident Date/Statute Date setting works, except users are permitted  to manually 

override the Statute Date in specific matters, when necessary. 

Å Incident/L ast Compensation/Statute Dates ɬ This setting is designed for  use in the 

Workers'  Compensation  law type, in which the Statute Date changes periodic ally 

depending on the Last Compensation Date. Prevail  w il l ini tially  calculate the 

Statute Date based on the Incident Date; thereafter, whenever the Last 

Compensation Date is entered or changed, Prevail  will  automatically  update the 

Statute Date, based on the parameters established in Case Type Setup. Users are 

not permitt ed to manually  override the Statute Date field.  

Å None - Use this setting for law types that do not have incident or statute dates. 

Å Onset Date/Date Last Insured ɬ This setting is designed for  use in Social Security  

and any other law type in which you have an onset date and date last insured, 

rather than a specific incident date. 

6 Enter the percent of a settlement that your  firm  will  receive, by default,  for  this law 

type in the "Settlement Percent" field.  You may change this percentage in individu al 

cases where the settlem ent percentage may differ  from  the norm. 

This default  settlement percentage is used in the settlement calculator on the 

Negoti ations tab. 

7 If  you wou ld like  to have a drop-down  list  on the Matter tab to choose a "Hearing 

Attor ney" (in addition  to being able to assign a "Lead Attor ney"), check the "Displ ay 

Hearing Attor ney" checkbox. Otherwise, leave this box unchecked. 

8 Click  'Save'.  
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Case Types 
 

Prevail  all ows you to set up an unlimited  number of case types wit hin a single law type. For 

example, under the Personal Injury  law type, you may have case types such as motor vehicle 

accident, slip  & fall,  wr ongful  death, etc. 

 

Follow  these steps to create a new case type. 

 

Step  Task 

1 Click  on Administration  > Law Type/Case Type/Contact Type Setup, and click on the 

Law Types tab at the bottom. 

2 In the lower -right section of the wi ndow,  click 'Add'.  

3 Enter a name for  the case type in the Description  field.  

4 Å If  this type of case has a Statute of Limit ations (SOL) date (for example, two  years 

for  a motor vehicle accident case), check the "Statute Date" box, and enter the 

number of years after the incident date that the SOL date will  occur. Then, enter the 

number of days prior  to the SOL date that this type of case should  appear in the 

Statute Warning List  on the Home tab. 

Å If  this type of case will  not have a Statute of Limit ations date, uncheck the "Statute 

Date" box. 

Å For Worker s' Compensation case types, also enter the number of years after the 

Last Compensation  Date that the SOL date will  occur. Prevail will  initially 

calculate the SOL date based on the incident date; later, each time you popul ate 

the Last Compensation  Date field  on the Matter tab, Prevail  will  recalculate the 

SOL date based on the number of years you enter in the "Compensation  Years" 

field  in Case Type Setup. 

5 Click  'Save'.  
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Case Types (continued) 
 

Follow  these steps to delete a case type. 

 

Step Task 

1 Click  on Administration  > Law Type/Case Type/Contact Type Setup, and click on the 

Law Types tab at the bottom. 

2 Click  once on the case type you want to delete. 

3 Click  'Delete'. 

4 Confirm  the deletion by clicking on 'Delete' again. 

 

Contact Types 
 

Prevail  all ows you to create an unlimited  number of party  types to use in your  Contacts and to 

attach to your  matters. 

 

 
 



 

28 
 

Contact Types (continued) 
 

Follow  these steps to create a new contact type. 

 

Step Task 

1 Click  on Administration  > Law Type/Case Type/Contact Type Setup, and click on the 

Contact Types tab at the bottom. 

2 Click  'Add'  on the top left  side of the wi ndow.  

3 Enter a name for  the new contact type in the "Description" field. 
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Contact Types (continued) 
 

Step Task 

4 In most cases, you will  leave the "Actio n" drop-down  menu blank. However,  for 

certain contact types, you may want the type to function like  a Referral Source, 

Employer,  or Medical Provider  in Prevail.  

Å Referral Source ɬ 3ÏÌɯ1ÌÍÌÙÙÈÓɯ2ÖÜÙÊÌɯɁ ÊÛÐÖÕɂɯÈÓÓÖÞÚɯàÖÜɯÛÖɯÙÌ×ÖÙÛɯÝÌÙàɯ

specifically on where your business comes from. For example, if you have TV 

commercials on several stationsȮɯàÖÜɯÊÖÜÓËɯÚÌÛɯÜ×ɯÈɯÊÖÕÛÈÊÛɯÛà×ÌɯÊÈÓÓÌËɯɁ35ɂɯÈÕËɯ

ÈÚÚÐÎÕɯÛÏÌɯ1ÌÍÌÙÙÈÓɯ2ÖÜÙÊÌɯɁ ÊÛÐÖÕɂɯÛÖɯÐÛȭɯ3ÏÌÕȮɯàÖÜɯÊÖÜÓËɯÚÌÛɯÜ×ɯÈɯÚÌ×ÈÙÈÛÌɯÊÖÕÛÈÊÛɯ

ÌÕÛÙàɯȹÜÚÐÕÎɯɁ35ɂɯÈÚɯÛÏÌɯÊÖÕÛÈÊÛɯÛà×ÌȺɯÍÖÙɯÌÈÊÏɯÖÍɯÛÏÌɯÚÛÈÛÐÖÕÚɯȹÌȭÎȭȮɯ"ÏÈÕÕÌÓɯƝȮɯ

Channel 13, Channel 28), and attach those to matters as appropriate. You would 

ÛÏÌÕɯÉÌɯÈÉÓÌɯÛÖɯÙÌ×ÖÙÛɯÖÕɯÏÖÞɯÔÈÕàɯÊÓÐÌÕÛÚɯÈÙÌɯÙÌÍÌÙÙÌËɯÛÖɯàÖÜɯÉàɯɁ35ɂɯÐÕɯÎÌÕÌÙÈÓȮɯ

and break down that total by referrals from each TV station.  

Å Employer  - When a contact is attached to a person as an Employer,  that contact 

will  displ ay both in the matter tree on the Matter tab, as well  as on the 

Employment tab. 

Also, when a contact is attached to a person as an Employ er, then that employer 

will  be listed on the Employment tab under "Employment from  Other 

Matters" in any other matters you have for  that client. 

If  you want the new contact type that you are creating to operate in this manner 

(i.e., 1) to be listed in the matter tree on the Matter tab and on the 

Employment tab, and 2) to be automatically  listed on the Employment tab 

under "Employme nt from  Other Matters"), then choose "Employer" from  the 

drop-down  menu. 

Å Medical Provider  - When a contact is attached to a person as Medical Provider,  that 

contact will  displ ay both in the matter tree on the Matter tab, as well  as on the 

Medical tab. 

Also, when a contact is attached to a person as a Medical Provider,  then that 

medical provider  w ill  be listed on the Medical tab under "Medical from  Other 

Matters" in any other matters you have for  that client. 

If  you want the new contact type that you are creating to operate in this manner 

(i.e., 1) to be listed in the matter tree on the Matter tab and on the Medical tab, and 

2) to be automatically  li sted on the Medical tab under "Medical from  Other 

Matters"), then choose "Medical Provider"  from the drop-down  menu. 

*Note: Some examples of contact types that you might want to create and treat like  

Medical Providers are hospitals and emergency medical services. 
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Contact Types (continued) 
 

Step Task 

5 Leave the "Act ive" box checked, so that the new contact type will  be avail able for  use 

in your  matters. 

6 If  you wou ld like  for  personal inform ation  (nickname, Social Security  number, gender, 

date of birt h, age, deceased status) to appear for  this contact type on the Matter tab 

(when you click on that party  in the matter tree), check the "Displ ay Personal 

Inform ation" checkbox. Otherwise, leave this box unchecked. 

7 If  this contact type is a client, check the "Client" checkbox, and choose the law type in 

which this contact type would  be the client. Otherwise, leave this box unchecked. 

For exampl e, if  you represent plaintiffs in Personal Injury  matters, then you would  

check the "Client" box, and choose the Personal Injury  law type for  the PI Plaintiff  

contact typ e. 

8 If  this contact type is your  opposition, check the "Oppositio n" checkbox, and choose 

the law type in which this contact type would  be the oppositio n. Otherwi se, leave this 

box unchecked. 

For exampl e, if  you represent plaintiffs in Personal Injury  matters, then you would  

check the "Oppositio n" box, and choose the Personal Injury  law type for  the PI 

Defendant contact type. 

*Note: If  you sometimes represent a contact type as the plaintiff,  and other cases as the 

defendant, check both the "Client" and "Opposit ion" boxes. 

9 Select the "Valid  Att ach Types" for  this contact type. This is where you select which 

other Contact types this one can be attached to on the matter tree. For example, 

suppose you wanted to create a Contact type called  "Co-Defendant," and you wanted 

to force it  to alw ays be attached to the Defendant. Then, for  the Co-Defendant contact 

type, you would  select Defendant from the Valid  Att ach Types list. You can select more 

than one type from the Valid  Att ach Types list. For example, Insurance Company, by 

default,  can be attached to the fol lowi ng types: ROOT (the matter itself), Defendant, 

Defendant Employer,  and PI Plainti ff. 

10 Click  'Save'.  
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Contact Types (continued) 
 

Follow  these steps to delete any unnecessary  contact types. 

 

*Note: Once a Contacts type has been attached to a matter, the progr am will  not all ow you to 

delete that type, unless and until  you detach that type from every single matter to which it w as 

attached. Also, you cannot delete a contact type if you have any Contacts with that type assigned to 

them, even if that contact is not attached to any of your matters. You may, however, make a Contact 

type Inactive by unchecking the "Act ive" box in the Contacts Type Setup. 

 

Step Task 

1 Click  on Administration  > Law Type/Case Type/Contact Type Setup, and click on the 

Contact Types tab at the bottom. 

2 Click  once on the contact type you want to delete. 

3 Click  'Delete'. 

4 Confirm  the deletion by clicking on 'Delete' again. 
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Query Manager  
 

The Query Manager allows  you to create custom queries to use with  the ɁMerge Across 0ÜÌÙàɂ 

feature, or to use with  the Matter Search function. A query is simply  a set of selection criteria  to 

find a specific subset of your  data. The reality,  however, is that database queries are quite 

geeky. Even if  you know how to write SQL (Simple Query Language) queries, wit hout knowi ng 

the names of the tables and the field  names where your  data is stored, you probably would nɀÛ be 

able to write  an effective query. Therefore, you will  probably require assistance from Prevail  

tech support  to create a query.  

 

Here are a few examples of how you might use a query: 

Ɉ Your firm  is moving to a new location, and you want to send a letter to all  your  cli ents 

(open & closed) to inform  them of the big event. 

Ɉ You want to send a letter to all  your  Social Security  clients, for  whom àÖÜɀÝÌ 

recently filed  an action, so you can let them know it  will  be several months before 

you get an answer. 

Ɉ You want to send a letter to all  of your  clients to let them know your  firm  has just hired 

a couple of new attorneys, and therefore can now provide  legal services you did nɀÛ 

offer before. 

 

Email support@prevail.net to request a custom query.

mailto:support@prevail.net
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Dashboard Designer  
 

The Dashboard  Designer allows  you to create a variety  of dashboards and share them with  as 

many users as you wish. The locked items are buil ding blocks you can use to build  your  own  

dashboards. You can also clone an existing dashboard  and modify  it  to suit your  needs. 

 

 

 

In the Dashboard  Designer, you may 

Å preview  a dashboard  by clicking on it  once 

Å double-click on a dashboard  to open it  for  editi ng (*Note: You cannot edit  a locked dashboard 

-- i.e., a dashboard with the padlock icon next to it.  If you double-cli ck a locked dashboard, it  will 

automatically clone it.) or 

Å clone a dashboard  by cli cking on it  once, and then clicki ng the 'Clone' button  at the top. 


































































































































































































































































































































































































































